Upon receipt of the product and prior to initial operation, read these instructions thoroughly, and retain for future reference.

MOTOMAN INSTRUCTIONS

PALLET SOLVER PC SETUP AND OPERATION MANUAL
CONTROLLER INSTRUCTIONS
OPERATOR’S MANUAL (for each purpose)
MAINTENANCE MANUAL

The operator’s manual above correspond to specific usage. Be sure to use the appropriate manual.

Terms of Use and Copyright Notice
All rights reserved. This manual is freely available as a service to Yaskawa customers to assist in the operation of Motoman robots, related equipment and software This manual is copyrighted property of Yaskawa and may not be sold or redistributed in any way. You are welcome to copy this document to your computer or mobile device for easy access but you may not copy the PDF files to another website, blog, cloud storage site or any other means of storing or distributing online content.

This software is the offline portion of a global offline/online palletizing solution. Any physical limit provided by this application is based on user inputs. For security purposes, any limit provided by this software should always be validated before being used on an automated system.

Users should carefully read this manual and understand the limitations of the product before using it.

AXIUM or Yaskawa America Inc. is not responsible for incidents arising from usage of this software.

Printed in the United States of America

First Printing, 2015

Yaskawa America, Inc.
Motoman Robotics Division
100 Automation Way
Miamisburg, OH 45342
Phone: 937-847-6200

www.motoman.com
WARNING

• This instruction manual is intended to explain mainly the software part of the PC Pattern Generation Tool for the PalletSolver Solution. It describes details necessary for the operating instructions. Be sure to read and understand this instruction manual thoroughly before installing and operating the PalletSolver PC Pattern Generation Tool.

• General items related to safety are listed in the Chapter 1: Safety of the controller instructions. To ensure correct and safe operation, carefully read the controller instructions before reading this manual.

CAUTION

• The drawings and figures in this manual are representative examples and differences may exist between them and the delivered product.

• Yaskawa may modify this product without notice when necessary due to product improvements, modifications, or changes in specifications. If such modification is made, the manual number will also be revised.

• If your copy of the manual is damaged or lost, contact a Yaskawa representative to order a new copy. The representatives are listed on the back cover. Be sure to tell the representative the manual number listed on the front cover.

• Yaskawa is not responsible for incidents arising from unauthorized modification of its products. Unauthorized modification voids your product’s warranty.
We suggest that you obtain and review a copy of the ANSI/RIA National Safety Standard for Industrial Robots and Robot Systems (ANSI/RIA R15.06-2012). You can obtain this document from the Robotic Industries Association (RIA) at the following address:

Robotic Industries Association  
900 Victors Way  
P.O. Box 3724  
Ann Arbor, Michigan 48106  
TEL: (734) 994-6088  
FAX: (734) 994-3338  
www.roboticsonline.com

Ultimately, well-trained personnel are the best safeguard against accidents and damage that can result from improper operation of the equipment. The customer is responsible for providing adequately trained personnel to operate, program, and maintain the equipment. NEVER ALLOW UNTRAINED PERSONNEL TO OPERATE, PROGRAM, OR REPAIR THE EQUIPMENT!

We recommend approved Yaskawa training courses for all personnel involved with the operation, programming, or repair of the equipment.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Notes for Safe Operation

Read this manual carefully before installation, operation, maintenance, or inspection of the manipulator.

In this manual, the Notes for Safe Operation are classified as “DANGER”, “WARNING”, “CAUTION”, or “NOTICE”.

**DANGER**
Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury. Safety Signs identified by the signal word DANGER should be used sparingly and only for those situations presenting the most serious hazards.

**WARNING**
Indicates a potentially hazardous situation which, if not avoided, will result in death or serious injury. Hazards identified by the signal word WARNING present a lesser degree of risk of injury or death than those identified by the signal word DANGER.

**CAUTION**
Indicates a hazardous situation, which if not avoided, could result in minor or moderate injury. It may also be used without the safety alert symbol as an alternative to “NOTICE”.

**NOTICE**
NOTICE is the preferred signal word to address practices not related to personal injury. The safety alert symbol should not be used with this signal word. As an alternative to “NOTICE”, the word “CAUTION” without the safety alert symbol may be used to indicate a message not related to personal injury.

**NOTICE**
To ensure safe and efficient operation at all times, be sure to follow all instructions, even if not designated as “DANGER”, “WARNING” and “CAUTION”.

---

169990-1CD

PC Pattern Generation Tool

Notes for Safe Operation
Registered Trademark

In this manual, names of companies, corporations, or products are trademarks, registered trademarks, or bland names for each company or corporation. The indications of (R) and TM are omitted.

Customer Support Information

If you need assistance with any aspect of your PC Pattern Generation Tool, please contact Yaskawa Customer Support at the following 24-hour telephone number:

(937) 847-3200

For routine technical inquiries, you can also contact Yaskawa Customer Support at the following e-mail address:

techsupport@motoman.com

When using e-mail to contact Yaskawa Customer Support, please provide a detailed description of your issue, along with complete contact information. Please allow approximately 24 to 36 hours for a response to your inquiry.

NOTICE

Please use e-mail for routine inquiries only. If you have an urgent or emergency need for service, replacement parts, or information, you must contact Yaskawa Customer Support at the telephone number shown above.

Please have the following information ready before you call Customer Support:

- Software
  - PalletSolver-PC
- Online System
  - DX200, YRC1000, MLX200 or MLX300
- Software Version
  - Access this information in the PalletSolver-PC application by selecting (Help) - (About PalletSolver)
- Robot Sales Order Number
  - Located on the controller data plate
# Table of Contents

1 Introduction ..................................................................................................................................... 1-1
   1.1 Software Requirements .....................................................................................................1 - 1
   1.2 PC Pattern Generation Tool Installation ............................................................................ 1-1
   1.3 Software Overview........................................................................................................ ..... 1-2

2 User Interface Overview ................................................................................................................. 2-1
   2.1 Main Screen....................................................................................................................... 2-1
      2.1.1 Menus.................................................................................................................. .2 - 1
         2.1.1.1 Files Menu............................................................................................... 2-1
         2.1.1.2 Edit Menu ................................................................................................ 2-2
         2.1.1.3 View Menu .............................................................................................. 2-2
         2.1.1.4 Project Menu ........................................................................................... 2-2
         2.1.1.5 Tool Menu ............................................................................................... 2-3
         2.1.1.6 Help Menu............................................................................................... 2-8
      2.1.2 Project Explorer.................................................................................................... 2-9

3 Defining Packages...................................................................................................................... 3-1
   3.1 Overview................................................................................................................. ........... 3-1
   3.2 Adding Packages.......................................................................................................... ..... 3-1
   3.3 Importing Packages....................................................................................................... .... 3-2
      3.3.1 Excel.................................................................................................................. ... 3-2
      3.3.2 CSV ...................................................................................................................... 3-3
   3.4 Editing Packages......................................................................................................... ...... 3-4
   3.5 Deleting Packages........................................................................................................ ..... 3-5

4 Defining Grippers.................................................................................................................. 4-1
   4.1 Overview................................................................................................................. ........... 4-1
   4.2 Adding Grippers.......................................................................................................... ....... 4-2
   4.3 Editing Grippers......................................................................................................... ........ 4-3
      4.3.1 Vacuum Grippers............................................................................................... 4-3
      4.3.2 Clamp Fixed Edge Gripper ............................................................................. 4-7
      4.3.3 Clamp Moving Edges Gripper .......................................................................... 4-8
      4.3.4 Fixed Fork Gripper .......................................................................................... 4-9
      4.3.5 Retractable Fork Grippers ............................................................................... 4-10
      4.3.6 Variable Stroke Fork Grippers ....................................................................... 4-11
      4.3.7 Bag Grippers..................................................................................................... 4-12
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.8 Gripper Pick Validation</td>
<td>4-12</td>
</tr>
<tr>
<td>4.4 Deleting Grippers</td>
<td>4-14</td>
</tr>
<tr>
<td>5 Defining Cells</td>
<td>5-1</td>
</tr>
<tr>
<td>5.1 Adding Cells</td>
<td>5-1</td>
</tr>
<tr>
<td>5.2 Editing Cells</td>
<td>5-2</td>
</tr>
<tr>
<td>5.2.1 Cell Components</td>
<td>5-2</td>
</tr>
<tr>
<td>5.2.2 Infeed Stations</td>
<td>5-3</td>
</tr>
<tr>
<td>5.2.3 Build Stations</td>
<td>5-6</td>
</tr>
<tr>
<td>5.2.4 Dispensing Stations</td>
<td>5-7</td>
</tr>
<tr>
<td>5.3 Deleting Cells</td>
<td>5-7</td>
</tr>
<tr>
<td>5.4 Modifying Cells</td>
<td>5-7</td>
</tr>
<tr>
<td>6 Defining Patterns</td>
<td>6-1</td>
</tr>
<tr>
<td>6.1 Adding Patterns</td>
<td>6-1</td>
</tr>
<tr>
<td>6.2 Importing Patterns</td>
<td>6-1</td>
</tr>
<tr>
<td>6.3 Editing Patterns</td>
<td>6-3</td>
</tr>
<tr>
<td>6.4 Pattern Components</td>
<td>6-4</td>
</tr>
<tr>
<td>6.5 Layer Design Editor</td>
<td>6-6</td>
</tr>
<tr>
<td>6.5.1 Overview</td>
<td>6-6</td>
</tr>
<tr>
<td>6.5.2 Commands</td>
<td>6-8</td>
</tr>
<tr>
<td>6.5.3 Pre-Defined Layer Styles</td>
<td>6-17</td>
</tr>
<tr>
<td>6.5.4 Layer Design Validation</td>
<td>6-18</td>
</tr>
<tr>
<td>6.6 Place Sequencing Editor</td>
<td>6-19</td>
</tr>
<tr>
<td>6.6.1 Overview</td>
<td>6-19</td>
</tr>
<tr>
<td>6.6.2 Creating a Sequence</td>
<td>6-20</td>
</tr>
<tr>
<td>6.6.3 Reviewing and Deleting Cycles</td>
<td>6-27</td>
</tr>
<tr>
<td>6.6.4 Place Sequencing Validation</td>
<td>6-28</td>
</tr>
<tr>
<td>6.6.4.1 Pick Validation</td>
<td>6-28</td>
</tr>
<tr>
<td>6.6.4.2 Placement Validation</td>
<td>6-29</td>
</tr>
<tr>
<td>6.7 Pallet Build</td>
<td>6-30</td>
</tr>
<tr>
<td>6.8 Generating Pattern Files</td>
<td>6-31</td>
</tr>
<tr>
<td>6.9 Coping Patterns</td>
<td>6-31</td>
</tr>
<tr>
<td>6.10 Deleting Patterns</td>
<td>6-31</td>
</tr>
</tbody>
</table>
Appendix A ............................................................................................................................................... A-1

A.1 Gripper Pick Validation Parameters .......................................................................................... A-1

A.1.1 Gripper Validation Rules ...................................................................................................... A-1
  A.1.1.1 Package must be covered by at least one grip area ..................................................... A-1
  A.1.1.2 Package cannot overlap two grip zones ........................................................................... A-2
  A.1.1.3 Package Center Control .................................................................................................. A-3
  A.1.1.4 Grip Zone Coverage ....................................................................................................... A-6
  A.1.1.5 Grip Area Coverage ....................................................................................................... A-7

A.2 Vacuum Gripper ......................................................................................................................... A-8

  A.2.1 Default Rules: .................................................................................................................... A-8

A.3 Clamp, Fork, and Bag Gripper .................................................................................................... A-13

  A.3.1 Default Rules: .................................................................................................................... A-13
1 Introduction

1.1 Software Requirements

The following are the minimum requirements to be able to use the PC Pattern Generation Tool:

- Windows PC (Windows 7 through Windows 10)
- Microsoft .NET Framework 4.5
- 400MHz processor, recommend 1 GHz
- 128 MB of RAM, recommend 1GB
- 30 MB hard disk space
- 1280 x 1024 screen resolution

1.2 PC Pattern Generation Tool Installation

1. Uninstall any previous version of PalletSolver PC Pattern Generation Tool through Add/Remove programs.
2. Run the setup.exe file included to install the new version of the PalletSolver PC Pattern Generation Tool program.
3. Follow instructions on the PalletSolver PC installation wizard to complete installation.
1.3 Software Overview

The PalletSolver software is used to generate pallet build information based on defined product, gripper and cell configuration. This build pattern will be specific to the cell chosen and specific to the infeed and pallet station chosen during the build process.

Pattern generation process flow is represented in **Fig. 1-1 “Pattern Generation Process”**:

*Fig. 1-1: Pattern Generation Process*

The user first defines the packages (boxes, bags, pallets and slipsheets), the grippers and the cells in the database. User then creates a pattern using the defined components. Once all the pattern creation steps are done and the pallet build is valid, the user generates the XML pattern files that will be exported to the palletizing cell.
2 User Interface Overview

2.1 Main Screen

The main screen offers an overview of the software. It is composed of multiple tools that help the user to edit the project in order to generate pattern files. The application menus and general toolbar are located at the top of the screen. To the left, you will find the project explorer that shows the project elements. The interface is mainly filled by the editor that will allow the user to edit the database and the defined patterns.

Fig. 2-1: Main Screen

2.1.1 Menus

2.1.1.1 Files Menu

By clicking on the File menu, you can create a new project, open an existing project, save the project, close the current project or exit the application. Saving the project requires a hardware key license that has to be inserted in the computer USB port.

If this is the first time that PalletSolver is being used, you can start a new project by selecting the File menu, then New, then New Project (or simply press Ctrl+N).

Fig. 2-2: New Project Dialog
2-2

User Interface Overview
2.1 Main Screen

When the Save As dialog appears, give the project a name by filling out the File name field. Select a directory to save the project and click Save.

2.1.2 Edit Menu
The Edit menu is visible when a project is opened. It is used to copy, paste and select items in the project.

2.1.3 View Menu
The View menu is used to show the application project explorer.

2.1.4 Project Menu
The Project menu is visible when a project is opened. It is used to add, import and export items to the opened project. Also, once the project is opened, you will be able to import and export an XML database.

To import an XML database to the current project, select the Project menu ➔ Import ➔ XML Database. Select the database XML file from the right directory. The Import Database dialog is displayed.

Fig. 2-3: Import Database Dialog

In the Tables to Import section, the user can select the database items to import. If Import Only Selected is checked, only selected elements will be exported. To select multiple items, hold [Ctrl] key and click on the row. Selecting all rows can be done with [Ctrl+A].

The Existing Data drop down offers the option to not add ID imported data that already exists or to replace/update if the imported data already exist in the opened project. Click Import to complete the database import.
2 User Interface Overview

2.1 Main Screen

To export the XML database of the current project, select the Project menu ➔ Export ➔ XML Database. Select the database XML file from the right directory. The Export Database dialog is displayed:

*Fig. 2-4: Export Database Dialog*

In the Tables to Export section, the user can select the database items to export. If Export Only Selected is checked, only selected elements will be exported. To select multiple items, hold Ctrl key and click on the row. Selecting all rows can be done with Ctrl+A. Click Export to complete the database export.

2.1.1.5 Tool Menu

The Tools menu is used to edit the general application settings and project settings. Select the Tools menu ➔ Options. The Options dialog is displayed.

*NOTICE*

The settings under the Application branch are global to the computer and applied to all projects opened on this computer. The settings under the Project branch are saved to the project file and will follow the project regardless of the computer used.
2.1 Main Screen

Pattern Output

Select the Application branch, then Patterns Output.

*Fig. 2-5: Pattern Files Output Directory Option*

The “Pattern Files Output Directory” will be the base directory where the pattern files are generated. It is recommended that you create a new directory for the generated pattern and that you identify the project in the name of the directory. You can copy/paste the path of the directory in the field or click the browsing button, to the right, to open the “Browse For Folder” dialog:

*Fig. 2-6: Browse for Folder Dialog*

Select the output directory and click {OK}.

The Pattern Files Output Directory is available to retrieve pattern files by right-clicking a pattern in the Project Explorer and selecting Open File Location.

If the Create Project and Cell Subdirectories checkbox:

- **is checked**, output pattern files will be located under the pattern files output directory in subdirectories with the project name and then the cell name underneath.
- **is unchecked**, all pattern files (regardless of the project or cell origin) are saved together directly to the output directory

If the Output build pattern 3D view file checkbox is checked, the built pallet 3D view image (png) will be generated with the output pattern file.
If the *Output Layer Style 2D view files* checkbox is checked, the place sequencing images (png) for each Layer Style will be generated with the output pattern file. Output images width and height can be specified in pixels.

- **Units**
  In the Options dialog, select the *Application* branch, then *Units*.

  *Fig. 2-7: Units Option*

  ![Units Option](image)

  You can choose metric or imperial units for the Dimensions and the Weight values. Note that if a project is opened, you must close and reopen the project to apply the units’ changes.

- **Data Type**
  Select the *Project* branch, then *Data Types*.

  *Fig. 2-8: Data Types*

  ![Data Types](image)

  This option allows changing the Product ID Type and the Pattern ID Type to a Numeric value between 0 and 32767 or an Alphanumeric 16 character string. Note that the Alphanumeric type may not be supported on all systems.
User Defined Data

Select the Project branch, then *User Defined Data*

*Fig. 2-9: User Denied Data Option*

The user defined data allows setting up to four user specific parameters that will be included in the pattern file. These user defined values are retrievable through the online system and can be used as inputs to add custom functions that are not normally supported by PalletSolver. For each user data, enter the displayed name and the type of data: Boolean (0=false; 1=true) or Integer (-32768 to 32767). If the Type is set to “None” the User Data is unused and will not display on the Pattern Components screen.

When user defined data fields are defined, extra checkbox (for Boolean type) or textbox (for integer type) with the data name will display at the bottom of the Pattern Components screen. Users can then enter pattern specific values that will be saved in each pattern file.

*Fig. 2-10: User Defined Info*
2. User Interface Overview

2.1 Main Screen

- **Pallet Build Editor**
  Select the *Project* branch, then *Place Build Editor*.

  You can define on this page the pallet build maximum height and maximum weight that can be applied to all the patterns when building the pallet.

  *Fig. 2-11: Pallet Max Build Height and Weight Option*

- **Security Check**
  Select the *Project* branch, then *Security Check* to display the security options.

  When enabled, this function will require the user to enter a password in order to access the gripper and cell definition and make changes. To enable the Security Check function, check the “Enable Security Check” checkbox and then enter the same password in the “Password:” and “Password Confirmation:” textbox.

  *Fig. 2-12: Security Check Option*
2 User Interface Overview

2.1 Main Screen

Once the function is enable, the user will be required to enter the password information in order to access the Gripper and Cell definition or to disable the Security Check function.

Fig. 2-13: Security Check Dialog

2.1.1.6 Help Menu

In the Help menu, select User Guide to open the application documentation in PDF format. Finally, the About PalletSolver displays the application information as well as the Hardware Key information (key ID and type) if it is inserted.

Fig. 2-14: About PalletSolver Dialog
2.1.2 Project Explorer

The project explorer displays the project elements in different branches so that you can browse them easily.

Double clicking the node will open the corresponding element editor in the Editor pane.

*Fig. 2-15: Project Explorer*

Right-click on item to display a context sensitive menu with options such as: Add, Delete, Copy to Cell, Generate Pattern File, Open File Location…

The project explorer can be docked by drag and dropping from the Project Explorer label. It can also be closed with the x button and opened through the View menu.
3 Defining Packages

3.1 Overview

The packages are defined by the user and are then used when defining the cells and the patterns. After clicking on the Packages node in the project explorer, the packages editor is opened:

*Fig. 3-1: Packages Editor*

<table>
<thead>
<tr>
<th>Package ID</th>
<th>Type</th>
<th>Name</th>
<th>Length (mm)</th>
<th>Width (mm)</th>
<th>Height (mm)</th>
<th>Weight (kg)</th>
<th>Quantity</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pallet</td>
<td>Example 1</td>
<td>1,200</td>
<td>900</td>
<td>400</td>
<td>20</td>
<td>100</td>
<td>NO</td>
</tr>
<tr>
<td>2</td>
<td>Pallet</td>
<td>Example 2</td>
<td>1,200</td>
<td>900</td>
<td>400</td>
<td>20</td>
<td>100</td>
<td>NO</td>
</tr>
<tr>
<td>3</td>
<td>Bag</td>
<td>Example 3</td>
<td>500</td>
<td>300</td>
<td>100</td>
<td>5</td>
<td>100</td>
<td>NO</td>
</tr>
<tr>
<td>4</td>
<td>Pallet</td>
<td>Example 4</td>
<td>2,000</td>
<td>1,500</td>
<td>700</td>
<td>30</td>
<td>150</td>
<td>NO</td>
</tr>
</tbody>
</table>

The toolbar Filter option is used to filter the packages by type: Boxes, Bags, Pallets and Slipsheets.

3.2 Adding Packages

You can add a new package from:

- Menu: Project ➔ Add New ➔ Package ➔ Package Type
- Toolbar: Add New ➔ Package ➔ Package Type
- Project Explorer: Right-click on Packages ➔ Add ➔ Package Type

The *Package Type* are Box, Bag, Pallet or Slipsheet.
3.3 Importing Packages

You can import Packages from Excel or CSV (comma separated values) files.

3.3.1 Excel

The Excel packages data must be in the first worksheet, starting at the first column and ending at the thirteenth column like in Table 3-2 “Excel Packages Format”.

### NOTICE

A numeric value must define the package type: 1 for box, 2 for pallet, 3 for slipsheet and 4 for bag. Also, the columns order must be respected and the row describing the columns titles is optional.

![Fig. 3-2: Excel Packages Format](image)

<table>
<thead>
<tr>
<th>Package ID</th>
<th>Type</th>
<th>Name</th>
<th>Length</th>
<th>Width</th>
<th>Height</th>
<th>Weight</th>
<th>Acceleration</th>
<th>Velocity</th>
<th>Label Position</th>
<th>Overlap Sides</th>
<th>Overlap Top</th>
<th>Overlap Bottom</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>box1</td>
<td>200</td>
<td>175</td>
<td>200</td>
<td>40</td>
<td>100</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>pallet</td>
<td>100</td>
<td>100</td>
<td>125</td>
<td>10</td>
<td>100</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>slipsheet</td>
<td>100</td>
<td>100</td>
<td>9</td>
<td>0.5</td>
<td>100</td>
<td>200</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

1. Select the Project menu, then Import → Packages → Excel
2. Select the file in the Open Dialog
3. Click Import to import the data.
3.3.2 CSV

The CSV packages data must be in the following format: Package ID, Type, Name, Length, Width, Height, Weight, Acceleration, Velocity, Label Position, Overlap Sides, Overlap Top, Overlap Bottom.

**NOTICE**

The columns order must be respected for the package type, a numeric value must define the package type: 1 for box, 2 for pallet, 3 for slipsheet and 4 for bag. Also, the columns order must be respected and that the row describing the columns titles is optional.

(1) Select the Project menu, then Import → Packages → CSV
(2) Select the file in the Open Dialog
(3) Click Import to import the data.

Fig. 3-3: Excel/CSV Packages Import

**NOTICE**

For both formats, all invalid rows will be ignored. In the Tables to Import section of the Import Packages dialog, you can select the database items to import. If “Import Only Selected” is checked, only selected elements will be imported, otherwise all the data will be imported. To select multiple items, hold [Ctrl] and click on the row. Selecting all rows can be done with [Ctrl+A]. The Existing Data drop down offers the option to not add ID imported data that already exists or to replace/update if the imported data already exist in the opened project. Click {Import} to complete the packages import.
### 3.4 Editing Packages

You can edit the packages by entering values in the grid. Cell selecting can be done with the mouse click or with the keyboard arrows. When a cell is selected, you can enter the value and press [Enter] to confirm the change or [Escape] to cancel it.

The different packages properties formats are presented below:

**Table 3-1: Packages Data Format**

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product ID</td>
<td>Integer (Numeric)</td>
<td>1</td>
<td>32767</td>
</tr>
<tr>
<td></td>
<td>String (Alphanumeric)</td>
<td>1 char</td>
<td>16 char</td>
</tr>
<tr>
<td>Name</td>
<td>String</td>
<td>1 char</td>
<td>50 char</td>
</tr>
<tr>
<td>Length (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Width (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Height (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Weight (kg)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>100</td>
</tr>
<tr>
<td>Acceleration (%)</td>
<td>Decimal</td>
<td>20</td>
<td>100</td>
</tr>
<tr>
<td>Velocity (%)</td>
<td>Decimal</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>Label Position</td>
<td>Integer</td>
<td>0</td>
<td>16</td>
</tr>
<tr>
<td>(box or bag)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overlap Sides (mm) (bag only)</td>
<td>Decimal</td>
<td>&lt;0</td>
<td>Width/2</td>
</tr>
<tr>
<td>Overlap Top (mm) (bag only)</td>
<td>Decimal</td>
<td>&lt;0</td>
<td>Length/2</td>
</tr>
<tr>
<td>Overlap Bottom (mm) (bag only)</td>
<td>Decimal</td>
<td>&lt;0</td>
<td>Length/2</td>
</tr>
</tbody>
</table>

**NOTICE**

Package height equal to 0 is allowed for pallets. This can be used to define a palletizing area in the case where there is no physical pallet.

For boxes or bags, you can select the label position with the Label Position Selection tool:

**Fig. 3-4: Label Position Selection Tool**
If one of the four labels is clicked, it will be displayed in red which means that the package has a label in that selected side. Clicking on a selected label will deselect it. The package label position will be calculated as a bitwise value from the selected labels sides.

For Bag, you can define overlap section around the bag. During the layer design phase, multiple overlap sections can be superimposed without generating an interference error. The side overlap is applied on both sides of the bag. The top and bottom overlaps are independent and can have different values. The overlap areas are displayed with a lighter color (note that they are not proportional to the entered overlap value in the Packages screen).

Fig. 3-5: Bag Overlap Definition

3.5 Deleting Packages

You can delete a package by selecting a row in the Package Editor and pressing the [Delete] key.

NOTICE

When deleting a package, any existing patterns that use that package will become invalid.
4 Defining Grippers

4.1 Overview

The grippers are defined by the user and are then used in the patterns. After clicking on the Gripper node in the project explorer, the gripper editor is opened as followed:

Fig. 4-1: Gripper Editor

At the top of the gripper editor, you will find a toolbar that contains a filter drop down to filter the grippers by type. It also contains some useful buttons to add elements that will be viewed later. On the left, you can see the defined Gripper List. In the Properties pane, you can edit the selected gripper properties. In the Virtual Gripper pane, you can define the virtual gripper that will be used in the place sequencing when a pattern is built. On the right, the Grip Areas and Sensors display a bottom view of the gripper where the physical grip areas and sensors can be defined. At the bottom, a help image is displayed to explain the different gripper physical properties.

When creating a new gripper, the user should add a gripper of the proper type. From the gripper CAD drawing, the user defines the physical gripper properties, grip areas and sensor areas in relation with the tool center point (TCP). It is important that the TCP defined in this application be the same as the one on the actual system. The user must then define one or more virtual grippers. The virtual gripper allows combining one or more grip areas and sensors into logical zones that facilitate the handling of packages.
4.2 Adding Grippers

You can add a new package from:

- Menu: Project ➔ Add New ➔ Gripper ➔ Gripper Type
- Toolbar: Add New ➔ Gripper ➔ Gripper Type
- Project Explorer: Right-click on Grippers ➔ Add ➔ Gripper Type

The Gripper Types are Vacuum, Clamp Fixed Edge, Clamp Moving Edge, Fixed Fork, Retractable Fork, Variable Stroke Fork or Bag Gripper.

When the New Gripper dialog appears, you can enter the Gripper ID and the Gripper Name. Click OK to create the new gripper.

**NOTICE**

The Gripper ID is used to validate the correspondence between the gripper defined in this application and the one defined on the actual system.

*Fig. 4-2: New Gripper Dialog*
4.3 Editing Grippers

4.3.1 Vacuum Grippers

You can edit the following vacuum gripper properties:

**Table 4-1: Vacuum Gripper Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String</td>
<td>1 char</td>
<td>50 char</td>
</tr>
<tr>
<td>-X Interference (mm)</td>
<td>Decimal</td>
<td>≥0</td>
<td>2000</td>
</tr>
<tr>
<td>+X Interference (mm)</td>
<td>Decimal</td>
<td>≥0</td>
<td>2000</td>
</tr>
<tr>
<td>-Y Interference (mm)</td>
<td>Decimal</td>
<td>≥0</td>
<td>2000</td>
</tr>
<tr>
<td>+Y Interference (mm)</td>
<td>Decimal</td>
<td>≥0</td>
<td>2000</td>
</tr>
</tbody>
</table>

The gripper dimension properties are used to calculate potential interference between the gripper and various stations. Therefore the dimension defined should be the overall dimensions of the gripper including any protrusions that may cause interference. TCP offsets values (-X, +X, -Y, +Y) should be positive.

The help image explains the physical properties of the vacuum gripper:

**Fig. 4-3: Vacuum Gripper Help Image**

You can then define the physical gripper by adding grip areas and sensors.

**NOTICE**

The grip area IDs and sensors IDs are used on the real system to map I/O signals that interact with each zone. It is therefore important to assign the proper IDs with the correct physical and logical locations.
4 Defining Grippers

4.3 Editing Grippers

To add a grip area, right click on the physical gripper then select Add Grip Area in the context menu. It can also be done with the Add Grip Area button in the grippers' toolbar.

*Fig. 4-4: Add Grip Area Menu*

A New Grip Area is created

*Fig. 4-5: New Grip Area*

The Grip Area can be moved to any position on the gripper. You can simply select the Grip Area and drag it with the mouse or move it using the arrow keys.

*Fig. 4-6: New Grip Area Moved*
Right click on the Grip Area to display its context menu. You will then be able to delete the Grip Area, set its position and resize it.

To add a sensor, right click on the physical gripper then select Add Sensor. It can also be done with the Add Sensor button in the grippers' toolbar.

**Fig. 4-7: Add Sensor Menu**

A new sensor is created:

**Fig. 4-8: New Sensor**

The sensor can be moved to any position on the gripper. You can simply select the sensor and drag it with the mouse or using the arrow keys.

**Fig. 4-9: New Sensor Moved**
You can define up to 32 grip areas and 32 sensors for each gripper.

*Fig. 4-10: Multiple Grip Areas and Sensors*

Once the physical gripper is defined, you can define up to eight virtual grippers for the selected gripper. To add a new virtual gripper, right click on the Virtual Grippers pane or click on the Add virtual Gripper Button in the toolbar. The Add Virtual Gripper dialog is displayed:

*Fig. 4-11: Add Virtual Gripper Dialog*

You must choose the number of zones (maximum 8) of the virtual gripper and then click OK. A new virtual gripper is added in the Virtual Grippers pane. The virtual gripper can be renamed or deleted through its context menu (by right clicking on the virtual gripper node). Deleting all the defined virtual grippers can be done through the context menu by right clicking after the last node in the Virtual Gripper pane.

To associate the physical gripper grip areas and sensors with the virtual grippers' zones, you can right click on the Grip Areas or the Sensors nodes.

First, right click on the Grip Areas node, then select Add Grip Area. In the Add Grip Area dialog, you can choose to define Grip Area ID and click OK.

*Fig. 4-12: Add Grip Area Menu and Dialog*
Second, right click on the Sensors node, then select Add Sensor. In the Add Sensor dialog, you can choose to define the Sensor ID.

*Fig. 4-13: Add Sensor Menu and Dialog*

You can add different grip areas to the same zone (same for sensors).

*N O T I C E*

A grip area or a sensor cannot be present in more than one zone for the same virtual gripper.

*Fig. 4-14: Grip Areas*

You can delete the selected grip area or the sensor by right clicking on it and then clicking on Delete from the context menu. It is also possible to clear all the grip areas of the zone by right-clicking on the Grip Areas node and then clicking on Clear Grip Areas from the context menu (same for sensors).

### 4.3.2 Clamp Fixed Edge Gripper

The Clamp Fixed Edge Gripper contains the same properties as the vacuum gripper. In addition, you can edit the following clamp specific properties:

*Table 4-2: Clamp Fixed Edge Gripper Properties*

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clamp #1 Thickness (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #1 Position (mm)</td>
<td>Decimal</td>
<td>-2000</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #2 Stroke (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #2 Thickness (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #2 Position (mm)</td>
<td>Decimal</td>
<td>-2000</td>
<td>2000</td>
</tr>
</tbody>
</table>
4.3  Editing Grippers

The help image explains the physical properties of the fixed edge clamp gripper.

Fig. 4-15: Clamp Fixed Edge Gripper Help Image

The procedure to add, edit and delete virtual grippers, grip areas and sensors is the same as the vacuum gripper. Each added grip area contains two clamps.

4.3.3 Clamp Moving Edges Gripper

The Clamp Moving Edges Gripper contains the same properties as the fixed edge clamp gripper. In addition, you can edit the Clamp #1 Stroke properties:

Table 4-3: Clamp Moving Edge Gripper Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clamp #1 Stroke (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Clamp #1 Thickness (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #1 Position (mm)</td>
<td>Decimal</td>
<td>-2000</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #2 Stroke (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #2 Thickness (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Paddle #2 Position (mm)</td>
<td>Decimal</td>
<td>-2000</td>
<td>2000</td>
</tr>
</tbody>
</table>

The help image explains the physical properties of the Clamp Moving Edges Gripper:

Fig. 4-16: Clamp Moving Edge Gripper Help Image
The procedure to add, edit and delete virtual grippers, grip areas and sensors is the same as the vacuum gripper. Each added grip area contains two clamps.

**Fig. 4-17: Grip Areas And Sensors For a Clamp Fixed Edge Gripper**

### 4.3.4 Fixed Fork Gripper

The Fixed Fork Gripper contains the same properties as the vacuum gripper. In addition, you can edit the following specific properties:

**Table 4-4: Fixed Fork Gripper Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall Position (mm)</td>
<td>Decimal</td>
<td>-2000</td>
<td>2000</td>
</tr>
<tr>
<td>Fork Length (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Fork Pitch (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Fork Width (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Package Max Height (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Package Min Height (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
</tbody>
</table>

**Fig. 4-18: Fixed Fork Gripper Help Image**
4.3 Editing Grippers

The procedure to add, edit and delete virtual grippers, grip areas and sensors is the same as the vacuum gripper. The grip areas can be moved only along the X-axis.

*Fig. 4-19: Fixed Fork Gripper Editor*

### 4.3.5 Retractable Fork Grippers

The Retractable Fork Gripper contains the same properties as the Fixed Fork Gripper. In addition you can edit the following specific properties:

*Table 4-5: Retractable Fork Gripper Properties*

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fork Max Stroke (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
</tbody>
</table>

*Fig. 4-20: Retractable Fork Gripper Help Image*

The procedure to add, edit and delete virtual grippers, grip areas and sensors is the same as the Fixed Fork Gripper.
4.3.6 Variable Stroke Fork Grippers

The variable stroke fork gripper contains the same properties as the fixed fork gripper. In addition, you can edit the following specific properties.

Table 4-6: Variable Stroke Fork Gripper Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fork Min Stroke (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>Fork Max Stroke (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
</tbody>
</table>

Fig. 4-21: Variable Stroke Fork Gripper

The procedure to add, edit and delete virtual grippers, grip areas and sensors is the same as the fixed fork gripper. The grips areas can be moved only along the X axis.
4.3.7 **Bag Grippers**

The bag gripper is similar to a combination of the dual clamp gripper and the fork gripper. To the fixed fork gripper, parameters for a second fork (Wall 2 Position and Fork 2 Length) are added. It is considered that the bags will be drop from a height that allows the fork to clear other bags on the same layer, so fork is not be considered in interference check with other bags. So in addition to the Fixed Fork Gripper property, for this gripper type, you can edit the following specific properties:

**Table 4-7: Variable Bag Gripper Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall 2 Position (mm)</td>
<td>Decimal</td>
<td>-2000</td>
<td>2000</td>
</tr>
<tr>
<td>Fork 2 Length (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
</tbody>
</table>

*Fig. 4-22: Bag Gripper Help Image*

The procedure to add, edit and delete virtual grippers, grip areas and sensors is the same as the fixed fork gripper. The grips areas can be moved only along the X axis.

4.3.8 **Gripper Pick Validation**

The pick validation parameters are common to all gripper types. For each gripper, you can edit the following specific properties:

**Table 4-8: Variable Fork Gripper Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package Center Control X</td>
<td>Decimal</td>
<td>-50%</td>
<td>50%</td>
</tr>
<tr>
<td>Package Center Control Y</td>
<td>Decimal</td>
<td>-50%</td>
<td>50%</td>
</tr>
<tr>
<td>GripZoneFullCoverage</td>
<td>Boolean</td>
<td>False</td>
<td>True</td>
</tr>
<tr>
<td>GripAreaSinglePackageCoverage</td>
<td>Boolean</td>
<td>False</td>
<td>True</td>
</tr>
</tbody>
</table>
The PackageCenterControlX and PackageCenterControlY parameters are percentages of package coverage in their corresponding axis. They specify the allowable position of the center of a package relative to the grip zone.

- If the percentage is negative, then the center of the package can be outside the zone by the specified percent of the package length.
- If the percentage is positive, then the center of the package must be inside the zone by at least the specified percent of the package length.

In short, at 0% the package center must be somewhere in the grip zone. Increase the percentage to require a larger portion of the package to be in the grip zone. Decrease the percentage to allow the center of the package to be further outside the grip zone.

**Fig. 4-23: Package Center Control**

GripZoneFullCoverage allows user to specify if a grip zone needs full coverage to be valid. Full coverage does not necessarily need to be achieved by a single package. If set to true, it would invalidate the following case where only one grip area of grip zone 2 is covered.

**Fig. 4-24: Grip Zone Full Coverage**
Defining Grippers

4.4 Deleting Grippers

GripAreaSinglePackageCoverage allows user to specify if a grip area can overlap two packages or needs to overlap only with one package. If set to true, it would prevent the following case where a suction cup (grip area 2) is between to package.

Fig. 4-25: Grip Area Single Package Coverage

Please see Appendix A.1 "Gripper Pick Validation Parameters" for information about pick validation.

4.4 Deleting Grippers

You can delete a gripper by selecting the gripper in the grippers list and pressing the Delete key or by right clicking on it and then selecting Delete from the popup menu.

NOTICE

If a gripper is deleted, all its grip areas, its sensors, and its virtual grippers will be deleted. Furthermore by deleting a gripper, any existing patterns that use that gripper will become invalid.
5 Defining Cells

The cells are defined by the user and are then used in the patterns.

5.1 Adding Cells

The user can add a new cell from:

- Menu: Project ➔ Add New ➔ Cell
- Toolbar: Add New ➔ Cell
- Project Explorer: Right-click on Cells ➔ Add Cell

The New Cell dialog is displayed:

Fig. 5-1: New Cell Dialog

You must enter the following information:

- Cell ID: Numeric
- Cell Name: string (maximum 50 characters)
- Gripper ID: select from the previously defined grippers
- Number of infeed stations: max 8.
- Number of Build stations: max 8. Number of infeed and build stations should normally be the same.
- Number of Pallet Dispensers: max 2. This property is disabled if no pallet is defined in the Packages.
- Number of the Slipsheet Dispensers: max 2. This property is disabled if no slipsheet is defined in the Packages.

Click OK to create the cell. The cell is now added to the Cells node in the project explorer.
5.2 Editing Cells

You can edit the previously defined cells.

5.2.1 Cell Components

Select the Cell Components tab.

*Fig. 5-2: Cell Components Editor*

**CAUTION**

Changing the selected gripper or the number of stations can invalidate existing patterns for this cell.

You can edit:

- Cell Name
- Selected Gripper (Gripper ID)
- Number of Stations
5.2.2 Infeed Stations

Select the Infeed Stations tab.

**Fig. 5-3: Infeed Station Editor**

You can edit each infeed station properties.

*Table 5-1: Infeed Station Properties*

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String</td>
<td>1 char</td>
<td>50 char</td>
</tr>
<tr>
<td>Alignment</td>
<td>Enum</td>
<td>Left, Right, Center</td>
<td></td>
</tr>
<tr>
<td>Width(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>2000</td>
</tr>
<tr>
<td>-X Interference(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>+X Interference(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>-Y Interference(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>+Y Interference(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>Gripper Orientation Restriction</td>
<td>Enum</td>
<td>None of the combination of 0, 90, 180, 270 degrees</td>
<td></td>
</tr>
<tr>
<td>Feed Type</td>
<td>Enum</td>
<td>Single Lengthwise, Multiple Lengthwise, Multiple Widthwise</td>
<td></td>
</tr>
<tr>
<td>Forkable Side</td>
<td>Enum</td>
<td>None, Left, Right, Both or Center</td>
<td></td>
</tr>
<tr>
<td>Roll Diameter(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>1000</td>
</tr>
<tr>
<td>Roll Pitch(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>1000</td>
</tr>
<tr>
<td>First Roll Offset(mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>1000</td>
</tr>
<tr>
<td>Robot Position X(mm)</td>
<td>Decimal</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Robot Position Y(mm)</td>
<td>Decimal</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
Defining Cells

5.2 Editing Cells

A right alignment will align the packages on the right of the infeed station frame. For a center or left alignment the width of the conveyor is used to calculate the proper package position from the infeed frame. The interference limits define the boundary of the gripper when picking at the infeed station.

The Gripper Orientation Restriction prevents positioning of the gripper in the listed orientation relative to the infeed station frame. These restrictions can be used to prevent motion alarms caused by gripper that cannot do a full 360 degrees rotation because of cabling restrictions.

*Fig. 5-4: Infeed Conveyor Standard Information*

When using a fork or bag gripper, the infeed Forkable Side must be set to a value other than “None”. Setting the forkable side to either “Left” or “Right” will prevent fork grippers from grabbing the package from the wrong side. In the case of a bag gripper, the forkable side should be set to “Both or Center”. The interference between the rolls of the conveyors and a fork or bag gripper are checked for interference. The information about the first roll position, the pitch between rolls and roll diameter are important for forkable conveyor. For a standard none forkable conveyor, these value are disregarded.

*Fig. 5-5: Forkable Conveyor Information*
A conveyor feed type can be defined as single lengthwise row, multiple lengthwise rows or multiple widthwise rows as illustrated in the following picture.

**NOTICE**

This PC software does not explicitly limit the maximum number of rows but it may be limited by the online controller software.

Fig. 5-6: Conveyor Feed Type

Robot position X and Y values display the robot relative position to the conveyor frame. When entering non-zero values, an icon displays the position of the robot in the Place Sequencing screen. This is just a reference to help the user in the sequencing planning and does not affect the pattern data.
5.2.3 Build Stations

Select the Build Stations tab.

Fig. 5-7: Build Station Editor

You can edit each build station properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Type</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>String</td>
<td>1 char</td>
<td>50 char</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enum</td>
<td>Length on X, Length on Y</td>
<td></td>
</tr>
<tr>
<td>-X Interference (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>+X Interference (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>-Y Interference (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>+Y Interference (mm)</td>
<td>Decimal</td>
<td>&gt;0</td>
<td>3000</td>
</tr>
<tr>
<td>Gripper Orientation Restriction</td>
<td>Enum</td>
<td>None or combination of 0, 90, 180, 270 degrees</td>
<td></td>
</tr>
<tr>
<td>Robot Position X (mm)</td>
<td>Decimal</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Robot Position Y (mm)</td>
<td>Decimal</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

The interference limits define the boundary of the gripper when placing at the build station. The help image below the build stations grid gives a visual representation of the station orientation and interferences. The Gripper Orientation Restriction prevents positioning of the gripper in the listed orientation relative to the build station frame. These restrictions can be used to prevent motion alarms caused by gripper that cannot do a full 360 degrees rotation because of cabling restrictions. Robot position X and Y values display the robots relative position to the conveyor frame. When a non-zero values are entered, an icon displays the position of the robot in the Place Sequencing screen. This is just a reference to help the user in the sequencing planning and does not affect the pattern data.
5.2.4 Dispensing Stations

Select the Dispensing Stations tab

Fig. 5-8: Dispensing Stations Editor

You can edit each dispensing station properties:

- Name: string (max 50 characters)
- Pallet/Slipsheet Orientation: Length On X or Length On Y
- Pallet/Slipsheet ID: Select from the previously defined pallets/slipsheets

**NOTICE**

The Pallet/Slipsheet orientation defines the orientation relative to the dispenser frame and is used for calculating the pick information of the Pallet/Slipsheet. For the place, the calculation is based on the build station orientation.

5.3 Deleting Cells

A cell can be deleted if it does not have any patterns defined. To delete a cell, you can right click on the cell (under Cells in the Project Explorer) and then click on Delete. This action can also be done by selecting the cell and clicking on the Delete button in the toolbar.

5.4 Modifying Cells

A cell’s station properties can be modified after patterns have been created but it may cause the existing patterns to become invalid.
6  Defining Patterns

The user can create a pattern using all the defined packages, grippers, cells in order to be able to build a valid pallet build and then generate the pattern file. In the project explorer, patterns are filtered by the cell that each pattern uses.

6.1  Adding Patterns

User can add a new pattern from:
- Menu: Project ➔ Add New ➔ Pattern
- Toolbar: Add New ➔ Pattern

This will add the pattern to the first cell by default. If you want to add a pattern to a particular cell, right click on the cell node under Patterns then click on Add New Pattern.

6.2  Importing Patterns

You can also import CAPE CRF (Robotic Interface file) and TOPS exported pattern files from:
- Menu: Project ➔ Import ➔ Pattern ➔ CAPE (CRF) or TOPS
- Project Explorer: right click on cell under Patterns node ➔ Import Pattern ➔ CAPE (CRF) or TOPS

You can select the CAPE or TOPS file in the Open dialog. The software will try then to match the file packages (box and pallet) name and dimensions with the database packages. If no match is found, you will be asked to add the new packages to the database:

Fig. 6-1: Import Packages Question
When you click OK, the Import Packages box is displayed:

*Fig. 6-2: Import Package Dialog*

You can enter the new packages ID and click OK to complete the CAPE pattern import.
6.3 Editing Patterns

Pattern edition can be performed using the Pattern Editor. Using this editor, user will go through four (4) different steps before being able to generate a pattern file. At the end of each step, a validation process is performed and user is allowed to next step only if current step is valid.

In first step, user basically chooses components from the project database like cell, pallet, slip-sheet, gripper, etc. On the second step, user will insert layers (called Layer Style) in the pattern either by choosing from a list of pre-defined Layer Styles or by inserting packages in a build area. Several tools are available to facilitate Layer Style design. On third step, user will have to make placement sequencing on each layer made from preceding step. This step is where all the pick/placement coordinates are generated into the pattern. Finally, user will be able to build a pallet by selecting components like pallet, slipsheet or any layers previously defined. Once all wanted layers have been placed on the build area, user then will be able to generate the Pattern Output File.

The next sections are describing each one of these 4 steps in details.
6.4 Pattern Components

In this step, you define all the pattern components.

**Fig. 6-3: Pattern Components Editor**

You can define:

- **Product**: Select from the defined packages and bags list.
- **Consider Labels**: select if the product labels are considered in the place sequencing step.
- **Pattern ID**: numeric value between 0 and 32767 or 16 characters alphanumeric string (see Data Type Options)
- **Pattern Name**: string (max 50 characters)
- **Max. Approach Magnitude**: numeric value greater or equal to 0. It is used to validate that there are no potential interference between the gripper/packages and the build station interference zone on the placement approach. This maximum value will be used on the actual system to restrict the allowable approach vector magnitude; the actual approach vector used on the real system could be set to a smaller value.
- **Cell**: Select from the defined cells list
- **Infeed Station**: Select from the defined infeed stations of the selected cell.
- **Infeed Stopper offset**: a value between -0 and 2000 (mm) to indicate the offset between the origin of the infeed and where the first product to pick is located along the X axis on the infeed.
6.4 Pattern Components

- **Build Station:** Select from the defined build stations of the selected cell.

- **Overhang/Underhang:** a value between -2000 and 2000 mm to indicate the product overhang/underhang on the pallet.

- **Pallet:** Select from the defined pallets list.

- **Pallet Source:** Select from defined pallet dispensers that are associated with selected pallet or select “External Handling” in the case where the pallet is not being handled by the robot.

- **Slipsheet 1:** Select from the defined slipsheets list.

- **Slipsheet 1 Source:** Select from defined slipsheet dispensers that are associated with selected slipsheet 1 or select “External Handling” in the case where slipsheet 1 is not being handled by the robot.

- **Slipsheet 2:** if slipsheet 1 is defined, you can define a second slipsheet

- **Slipsheet 2 Source:** if slipsheet 1 is defined, select from defined slipsheet dispensers that are associated with selected slipsheet 2 or select “External Handling” in the case where the slipsheet 2 is not being handled by the robot.
6.5 Layer Design Editor

At this step, every component (pallet, box, conveyor, gripper, etc.) to use in the pattern build process have been selected and validated. User is now ready to start creating some layers (currently referred as Layer Styles). This can be accomplished either by adding and moving packages (boxes or bags) in a build area or importing some pre-defined Layer Styles.

6.5.1 Overview

Fig. 6-4: Layer Design Editor

The editor is made of four (4) main components:

- The list of created/imported Layer Styles
- The build area where the selected Layer Style from the list is displayed
- The Toolbar which provides tools to work on the design
- The Pop-Up Menu which also provides tools to work on the design

From the Layer Style list control, user can add, remove or rename Layer Styles in the pattern. This is also where all the pre-defined Layer Styles are accessible.
The main control of this editor is the build area. This is where the user can move packages around to create or modify Layer Styles. The basics of this control is a 2D view with scale (zoom using mouse wheel) where user can select one or several items at the same by holding the CTRL key and either by clicking on items one at a time, or in making a selection rectangle by moving the mouse while holding the left button. Once some packages are selected, a lot of commands are available to the user for manipulating them. Next section explains these commands in detail.

*Fig. 6-5: Rectangle selection made by holding CTRL key and moving mouse left button down*
### 6.5.2 Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard</th>
<th>Toolbar</th>
<th>Pop-up Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Layer Style</td>
<td></td>
<td><img src="image1" alt="Add" /></td>
<td>Add Layer Style (Add)</td>
</tr>
<tr>
<td>Remove Layer Style</td>
<td></td>
<td><img src="image2" alt="Delete" /></td>
<td>Remove Layer Style (Delete)</td>
</tr>
<tr>
<td>Rename Layer Style</td>
<td></td>
<td>Rename</td>
<td></td>
</tr>
<tr>
<td>Add Package</td>
<td><img src="image3" alt="Insert" /></td>
<td><img src="image4" alt="Add Package" /></td>
<td>Add Package (Insert)</td>
</tr>
<tr>
<td>Delete Package</td>
<td><img src="image2" alt="Delete" /></td>
<td><img src="image4" alt="Delete Package" /></td>
<td>Delete Package (Delete)</td>
</tr>
<tr>
<td>Rotate item</td>
<td><img src="image5" alt="R" /></td>
<td><img src="image6" alt="Rotate Item(s)" /></td>
<td>Rotate Item(s) (r)</td>
</tr>
<tr>
<td>Move item</td>
<td></td>
<td>Move Items</td>
<td></td>
</tr>
<tr>
<td>Set Item Position</td>
<td></td>
<td>Set Item Position</td>
<td></td>
</tr>
<tr>
<td>Center on Pallet</td>
<td><img src="image7" alt="C" /></td>
<td><img src="image8" alt="Center on Pallet" /></td>
<td>Center on Pallet (c)</td>
</tr>
<tr>
<td>Align items Top</td>
<td><img src="image9" alt="Align" /></td>
<td><img src="image10" alt="Align Item(s)" /></td>
<td>Align Item(s) Top</td>
</tr>
<tr>
<td>Align Items Bottom</td>
<td><img src="image9" alt="Align" /></td>
<td><img src="image10" alt="Align Item(s)" /></td>
<td>Align Item(s) Bottom</td>
</tr>
<tr>
<td>Align Items Left</td>
<td><img src="image9" alt="Align" /></td>
<td><img src="image10" alt="Align Item(s)" /></td>
<td>Align Item(s) Left</td>
</tr>
<tr>
<td>Align Items Right</td>
<td><img src="image9" alt="Align" /></td>
<td><img src="image10" alt="Align Item(s)" /></td>
<td>Align Item(s) Right</td>
</tr>
<tr>
<td>Flip in X-axis</td>
<td><img src="image11" alt="Flip X" /></td>
<td><img src="image12" alt="Flip in X-axis" /></td>
<td>Flip in X-axis (x)</td>
</tr>
<tr>
<td>Flip in Y-axis</td>
<td><img src="image13" alt="Flip Y" /></td>
<td><img src="image12" alt="Flip in Y-axis" /></td>
<td>Flip in Y-axis (y)</td>
</tr>
<tr>
<td>Set Labels Out</td>
<td><img src="image14" alt="Set Labels Out" /></td>
<td><img src="image12" alt="Set Labels Out" /></td>
<td>Set Labels Out (O)</td>
</tr>
<tr>
<td>Set Item Gap X</td>
<td></td>
<td><img src="image15" alt="Set Item Gap X" /></td>
<td>Set Item(s) Gap X</td>
</tr>
<tr>
<td>Set Item Gap Y</td>
<td></td>
<td><img src="image16" alt="Set Item Gap Y" /></td>
<td>Set Item(s) Gap Y</td>
</tr>
</tbody>
</table>
6-9

#### Defining Patterns

#### 6.5 Layer Design Editor

- **Add Layer Style**
  Execute to create a new empty Layer Style. User will then have to insert packages (boxes or bags) into this newly created Layer Style.

- **Remove Layer Style**
  Select a Layer Style in the list and you can execute remove.

  **NOTICE**
  Only one Layer Style can be removed at a time

- **Rename Layer Style**
  You can specify any name for your Layer Styles. Even if the program is allowing duplicate names, it is strongly suggested to keep these names unique so user will not see any duplicates that refers to the list of Layer Styles.

- **Add Package**
  Use this command to insert a new packages (boxes or bags) into the displayed Layer Style. When this command is executed using the mouse right-click and there is no package currently selected, the package is inserted at the right-click location. When this command is executed while some packages are selected, program will insert the new package next to the segment formed by all selected items. It will first try at the right of the segment. If there is a collision, it will try to insert at the top, then on the left and then at the bottom. If there is a collision at the four locations, package will be inserted at the bottom.

- **Remove Package**
  User must select one or several packages and can delete using this command.

- **Rotate Item(s)**
  When executed, this command will make a 90 clockwise rotation on selected item. If there is more than one selected item, the same rotation is applied but on the segment formed by all selected items.

- **Move Item(s)**
  Enter the distance to shift selected items. User can specify a distance in X-axis, in Y-axis or both at the same time.

- **Set Item(s) position**
  Enter the new position of the selected item. If there is more than one selected items, the same translation is applied on all the other selected items.

- **Center On Pallet**
  All selected items will shift at a position where the center of the segment formed by all selected items is at the center of the pallet.

- **Align Items Top**
  All selected items will align their top with the topmost selected items. If command is executed from the right-click pop-up menu, all selected items will align their top with item that was clicked.
6. Defining Patterns
6.5 Layer Design Editor

- **Align Items Bottom**
  All selected items will align their bottom with the bottommost selected items. If command is executed from the right-click pop-up menu, all selected items will align their bottom with item that was clicked.

- **Align Items Left**
  All selected items will align their left with the left most selected items. If command is executed from the right-click pop-up menu, all selected items will align their left with item that was clicked.

- **Align Items Right**
  All selected items will align their right with the right most selected items. If command is executed from the right-click pop-up menu, all selected items will align their right with item that was clicked.

- **Set Labels Out**
  All selected items will rotate so at least one of their labels will be on the outside of the pattern.

*Fig. 6-6: Set Labels Out Command*

- **Flip in X-axis**
  This command will flip, in the X direction, the segment formed by all selected packages. The movement is that packages will be switching positions left-right and packages that are at 0 or 180 degree orientation are rotating by 180 degree. The next image is showing the transformation.

*Fig. 6-7: Flip in X-axis Command*
6.5 Layer Design Editor

- **Flip in Y-axis**
  This command will flip, in the Y direction, the segment formed by all selected packages. The movement is the packages are switching positions top-bottom and packages are at a 90 or 270 degree orientation that are rotating by 180 degree. The next image is showing the transformation.

  *Fig. 6-8: Flip in Y-axis Command*

- **Set Item(s) GapX**
  Use this command to set a gap in the X direction on selected packages. This gap will be represented as a rectangle surrounding the packages. This gap is applied when using the snap feature on the packages (see snap feature).

  *Fig. 6-9: Items with a Gap in X-axis*
6 Defining Patterns
6.5 Layer Design Editor

- **Set Item(s) GapY**
  
  Use this command to set a gap in the Y direction on selected packages. This gap will be represented as a rectangle surrounding the package. This gap is applied when using the snap feature on the package (see snap feature).

  *Fig. 6-10: Items with a Gap in Y-axis*

- **Snap Feature**

  The snap is a feature that gives the user an easy way of placing packages next to each other. There are three modes to the snap: Inactive, Active and Spread. This mode can be changed in the top toolbar. The next images are showing examples of snap feature. As we have seen before, using the mouse, user is able to select packages and then move the segment created by these packages by holding the mouse left button and moving the cursor.

  When the snap mode is active, the idea is to put a moving segment (or just one package) close enough to some non-moving packages so that small circles appear between the moving and fix packages. By moving the packages around the snapping circles will dynamically update to the closes corners or edge midpoint. Upon releasing this segment, all moving packages will adjust their position so that the center of the snapping circles line up.

  *Fig. 6-11: With snap enabled as packages are moved closer to fixed packages snapping circles appears.*

**NOTICE**

User can have a moving segment spread while in Active mode by holding the “S” key while snapping packages.
In the spread mode, the idea is to put a moving segment (multiple packages) slightly in collision with some non-moving packages so that the edge of any moving packages that is the nearest to the edge of the non-moving packages will be aligned and packages spread evenly along the intersection edge.
Fig. 6-13: With spread snap, when the moving packages are released on top of fixed packages, the moving packages are spread evenly along the closest edge of the intersecting non-moving packages.

Snap function will also work in conjunction with gaps.

Fig. 6-14: Gaps around packages generates extra corners and mid-points to snap to.
In the case of bags, the overlap areas of bags can be superimposed. The overlap section also create extra corners for the snap function.

Fig. 6-15: Bag Overlap Examples
### Copy and Paste

A Layer Style can be copied/pasted from the popup contextual menu. User right clicks on a Layer Style in the Layer Style list and then copy/paste.

*Fig. 6-16: A Layer Style can be Copied/Pasted using the Commands from the Popup Menu*

Once a Layer Style has been copied, user can use any command to modify it as wanted.

As an example, the user wants to create a mirror Layer Style. The way of doing this is to copy and paste a Layer Style, then select all the packages inside and use the Flip in X-axis or Flip in Y-axis command.

Packages inside any Layer Style can also be copied and pasted into another Layer Style (or the same one). User have to select all the packages that need to be copied and then copy/paste.

*Fig. 6-17: Packages in a Layer Style can be copied/pasted using the commands from the popup menu*
This software comes with up to 250 pre-defined Layer Styles that user can easily import into their patterns. This list of pre-defined Layer Styles can be accessed by pressing on the button right below the Layer Styles list. From that list, user can select a Layer Style and hit or simply double-click on a Layer Style to import it into the pattern.

Software will automatically adjust the imported Layer Styles to fit with the pattern package size and recommend the patterns with the most packages fitting on the pallet at the top of the list. If for some reason the pattern you are looking for is not in the list, you can check the “Show All” checkbox in the top left corner to display all available patterns. If an additional gap between packages is needed, user can ask the software to add gap in x- or y-axis upon importing the Layer Styles by entering a gap value either in “Gap X” or “Gap Y” textbox.

If labels are to be considered, user can ask to put the labels out upon importing by checking the “Make Labels Out” check box.
6.5.4 **Layer Design Validation**

This process is performed in two different situations:

- User is currently in the Layer Design step and click to go to Place Sequencing step;
- The “Generate Output File” command is executed;

For each Layer Style present in the pattern, this process is validating:

- Packages outside or in collision with build station constraint;
- Packages outside or in collision with pallet overhang;
- Packages in collision with other packages;

*Fig. 6-19: User cannot access the place sequencing if a Layer Style is invalid.*
6.6 Place Sequencing Editor

At this step, every component (pallet, box, conveyor, gripper, etc.) to be used in the pattern build process has been selected and validated and user already has created or imported some Layer Styles. Now, user needs to specify the pick/placement sequence information for each one of the previously created/imported Layer Styles.

6.6.1 Overview

The following figure is showing the components of the place sequencing. This editor is made of three main components.

On the left, this is the infeed station display. Using this view, user can see and modify the pick portion of the sequencing. On the right, we can see the build station display from where user can specify the sequence to build a Layer Style. If the Robot Position values are set in the infeed and build stations definition, a robot icon is displayed to indicate the relative position of the robot to the station frame to help the user plan the sequencing. Finally at the top, there is the toolbar providing tools to select, modify and navigate through the sequencing of a Layer Style.

Fig. 6-20: Place Sequencing Editor
On each package (box or bag), there is some information displayed regarding the sequencing. User can read the cycle and placement number, the approach vector and the zone of the gripper used to place a particular package.

*Fig. 6-21: Information displayed on a package*

### 6.6.2 Creating a Sequence

The sequence to build a whole Layer Style is divided into cycles. For each cycle, user must make and validate the pick, then make all needed placement(s) to drop all packages (boxes or bags) present on the gripper. Only then user will be allowed to move on to the next cycle. This process is repeated until all packages have been placed.

First step is to select a Layer Style from the Layer Styles Dropbox in the top toolbar. Once selected, you can see the skeleton from the Layers Design in the build station display. In the infeed station, a first pick is created with the gripper configuration that can fit the most number of packages.

*Fig. 6-22: Select a Layer Style from the List*

Once a new cycle is created, on the infeed we can see the gripper filled with the maximum number of packages it can hold. On the build station, we see the same gripper with the same amount of packages.
We can see that validation messages in both stations are saying: “Currently Picking”, meaning it is time to modify the pick (if needed) because once you have started making placements for a cycle, you can no longer modify its pick. At the Picking stage, user is basically allowed to:

- Add or remove package from the infeed station either by right-clicking on it (pop-up menu) or by using top toolbar shortcuts
- Change the package orientation on the conveyor either by right-clicking on it (pop-up menu) or by using top toolbar shortcuts
- Add or remove rows from the infeed station either by right-clicking on it (pop-up menu) or by using top toolbar shortcuts (for Multi-row Conveyor only)
- Change the selected virtual gripper on the toolbar
- Select a pick from the pick selection table. This table is a list of all valid picks for the currently selected Virtual Grippers starting from the most efficient (more boxes, closest to origin, etc.) to the least efficient.
- Modify the position of the gripper on the infeed by dragging it using the mouse.
- Modify the orientation of the gripper on the infeed by right-clicking on it (pop-up menu)

![Fig. 6-23: Toolbar for infeed station commands.](image)

In the case of a multi-row conveyor, extra rows can be added or removed. By default, the new row will be the same as the previous one. Packages on the last row can be turned, added or removed. All the packages in the same row will have the same orientation. Packages orientation can only differ between rows.
Defining Patterns

6.6 Place Sequencing Editor

Fig. 6-24: Multiple Widthwise Row Pick Example

Index numbers appear on each package, the number on the left is the row index and numbers on the right is the overall package index.

Fig. 6-25: Infeed Package Indexes
The Pick Selection menu will display the Pick Selection dialog that lists all valid picks for the currently selected Virtual Gripper starting from the most efficient pick to the least efficient pick. When selecting one of the choices, the selected pick is displayed in the infeed display section. Press OK to accept it or Cancel to return to the pick position from before opening the Pick Selection dialog.

*Fig. 6-26: Pick Selection Dialog*

So by using any of these means, user is able to create the wanted pick. It is important to note here that while the user is modifying the pick, it may become in a state where it is invalid (see *Fig. 6.6.4 “Place Sequencing Validation” on page 6-28*). In this case, the build station will be disabled and there will be a validation error message displayed on top of infeed station to help user fix the situation. User will be allowed to use the build station only when the pick will be in a valid state.

After the new pick has been validated, user can now start dropping packages using the build station to create placements. This can be achieved by clicking on any free package skeleton on the build area.

*Fig. 6-27: Click on a Package Skeleton on the Build Station to Align the First Package on Gripper. Click Again to Move by One Package.*
As user clicks on a skeleton, program will automatically align the first package on gripper with the clicked skeleton. If user clicks a second time on the same skeleton (now covered by the first package on gripper), program will align the second package and so on for every package present on the gripper. When the last package is aligned on and user click again, there is two possibilities.

- If “Consider labels” option is selected, as packages must match the full orientation (0, 90, 180 or 270 degree), the alignment will go straight back to the first package;
- “Consider labels” option is not selected, as packages must only match the axis (0=180 and 90=270), gripper will rotate by 180 degree then the alignment will go back to the first package.

Program is showing some information about what can be done at the current position.

- A green package means that it is in a gripper zone ready to drop
- A blue package means that it was dropped in current displayed Cycle/Placement
- A zone that can be dropped will have a “Click to drop zone” flag right next to it
- A zone that was already dropped will have a “Zone Dropped” flag right next to it
- An active zone is blue
- An inactive zone is transparent
- Gripper in collision is displayed in red
- Packages in collision are displayed in red as well
- For clamp grippers, clamps in collision are displayed in red as well

As an alignment is done on a skeleton, only valid positions are iterated through. If there are no valid position, then all the invalid positions will be displayed to help the user identify the issue and resolve it.

**NOTICE**

Depending on configuration, it is possible that a pattern cannot be finished.
When user is ready to drop a zone, a single-click on the flag “Click To Drop Zone” will make the zone drop its packages. In a build cycle, once placement is started (first package has been dropped), user cannot modify the pick until all the packages are dropped, so the infeed station area will become disabled.

Fig. 6-28: Click on a “Click To Drop Zone” to Release Packages Held in that Zone
Every time a zone is released, if there are other zones ready to drop at current position, user can either drop some other packages in the current placement, or click on another skeleton in order to find another valid drop position in which case, the editor will automatically generate a new placement since the drop position has changed since the last drop. Once at the new drop position, the user can drop packages at the new placement. Next figures are showing examples.

**NOTICE**

Returning to the preceding drop position will not cancel the newly created placement. In other words, after dropping a package if you move the gripper to another drop location, a placement is automatically generated. The user have to make sure to drop everything he wants to drop before moving to another drop location otherwise the cycle will have to be canceled and restarted.

*Fig. 6-29: Multiple drops at one location or at multiple location option.*
Every time the gripper is moved at a drop position, the program is generating automatically the approach vector that should be used to make this drop. It is represented by red arrows on packages.

Fig. 6-30: Program automatically generates the approach vector when gripper is at a drop position. We can see that the red arrow on the package to drop is pointing toward the package from the previous cycle.

However, if the automatically generated vector needs to be changed, it can be done pressing on the (Approach Vector) button. This will show a dialog where user can change the vector for the currently displayed placement.

In the case of bag packages, there is an extra “High Drop” property in the toolbar next to the approach vector button. When the “High Drop” checkbox is checked, it indicates that the bag will be dropped from a higher position to avoid interference between the gripper opening claws and any bags already placed on the layer. By default, bag placement is high drop and their default approach vector is straight down.

When there are no more packages on gripper, the current cycle is finished. At this point, the next cycle is automatically started if there are more packages to place. The new cycle default pick will be the same as the last cycle. Once all the packages have been placed, the sequence can be reviewed using the navigation pane (last / next). User can also cancel the last cycle and redo it if needed.

This procedure will have to be repeated for every Layer Style present in the pattern. The user will only be allowed advance to the Pallet Build Editor when all Layer Styles are done and valid.

6.6.3 Reviewing and Deleting Cycles

Navigation is made using the back and next buttons in the navigation pane. While reviewing the sequence the user can make adjustments to the Approach Vectors and the bag's High Drop properties.

Since a cycle is dependent on all previous ones, a cycle in the middle of the sequence cannot be removed. Only the last cycle can be deleted by pressing on the (Delete) button.

All cycles can be deleted at once by pressing the (Delete All) button.
6.6 Place Sequencing Editor

6.6.4 Place Sequencing Validation

This process is performed for two different situations:

- User is currently in the Place Sequencing step and clicks to go to the Pallet Build step;
- The “Generate Output File” command is executed.

For each Layer Style present in the pattern, this process validates all the build cycle (picks/placements) information.

6.6.4.1 Pick Validation

- Packages are neither outside nor in collision with the infeed station constraint.
- Packages are not in collision with other packages.
- Gripper is neither outside nor in collision with the infeed station constraint.
- All packages on the conveyor needs to be picked.
- A package cannot be shared by two gripper zones (there can be several packages per zone).

Pick Validation tolerances must be respected (see Appendix A.1 "Gripper Pick Validation Parameters" for more information about pick validation)

Below are default validation for the various grippers.

**NOTICE**

Some validation can be adjusted by modifying properties in the gripper definition.

- **For Vacuum Grippers Only:**
  - A zone picking packages needs to be completely covered.

- **For Clamp Grippers Only:**
  - Gripper clamps are not in collision with packages.
  - Gripper clamps are neither outside nor in collision with infeed station constraint.
  - Package is not too small for the stroke of clamps.
  - Package is not too big for the stroke of clamps.

- **For Fork and Bag Grippers:**
  - Gripper forks are neither outside nor in collision with infeed station constraint.
  - Gripper forks can fit between conveyor rolls.
  - The package height must be between the package minimum height and package maximum height parameters.
  - Package is not too small to be picked by the forks.
  - Package is not too big to be picked by the forks.
  - Gripper X position is valid only when the gripper forks are not in collision with conveyor rolls.
6 Defining Patterns
6.6 Place Sequencing Editor

- For Fork Only:
  - The package needs to be over the forks at least by Y% of its dimension along the conveyor.
  - Gripper Orientation must match conveyor forkable side.

- For Bag Grippers Only:
  - Bag must intersect with forkset1 and forkset2

6.6.4.2 Placement Validation

- Any package on the build station must match the position and orientation of a skeleton from the layer design step.
- Packages are neither outside nor in collision with build station constraint.
- Packages are not in collision with other packages.
- Gripper is neither outside nor in collision with build station constraint.

- For Clamp Grippers Only:
  - Gripper clamps are neither outside nor in collision with build station constraint.
  - Gripper clamps are not in collision with packages.
  - An empty zone must not interfere with previously dropped packages.

- For Fork Grippers Only:
  - Gripper forks are not in collision with build station constraint (see NOTICE below…).
  - Gripper forks are not in collision with previously dropped packages (see NOTICE below…).
  - An empty forks zone must not interfere with previously dropped packages (see NOTICE below…).
  - Gripper forks can be retracted (fork stroke) without creating collision with packages from previous cycle. The dimension of the constraint is fork stroke +25 mm starting from the sidewall position.
  - Gripper forks can be retracted (fork stroke) without creating collision with the build station constraint. The dimension of the constraint is fork stroke +25 mm starting from the sidewall position

- For Bag Grippers Only:
  - It is considered that the bags will be drop from a height that allows the forks to clear other bags on the same layer, so the forks are not considered in interference check with other bags.

**NOTICE**

Since there is no information on the location of the forks after a drop (in or out), the interference check will consider forks to be taking the whole space of its stroke.
6.7 Pallet Build

In this last step, you can build a pallet using the defined layers styles:

*Fig. 6-31: Pallet Build Editor*

You can add a layer by double clicking on the Layer Style or by selecting the Layer Style in the list and clicking on the Add Layer Style button in the toolbar. A layer is always added at the end of the current list of layers.

As layers are added, the current build height and weight fields are updated.

If Define Max Build is checked, Max Build Height and the Max Build Weight of the pallet that were set in the Options menu will be enabled. Therefore, if you try to add a layer that makes the pallet height or weight exceeding the maximum allowed, you will be notified that it cannot be added.

In the Layers List, you can select the layer to set the top layer in the 3D view of the pallet.

You can delete a layer from the layers list by selecting the row corresponding to the layer and then pressing the Delete key.
6.8 Generating Pattern Files

Once the built pattern is valid, you are able to generate the pattern file. This can be done in the Pallet Build editor by clicking on the Generate Pattern File button 📋 in the toolbar. It can also be done by right clicking on the pattern in the Project Explorer and then clicking on Generate Pattern File.

The pattern files and images will be generated in the Pattern File Output Directory in the Options menu. Each pattern is saved in the sub folder:

\{ProjectName\}\Cell \{ID\}\%

\{ProjectName\} - relates to the project name the pattern belongs to.
\{ID\} - relates to the generated pattern cell ID.

The output pattern file name is composed of ProductID, PatternID, CellID, BuildStationID as follows:

ProductID,PatternID,CellID,StationID.xml

Once generated, the output file name is displayed next to the corresponding pattern name in the project explorer.

6.9 Coping Patterns

To copy a whole pattern, right click on the selected pattern, then Copy To Cell:

*Fig. 6-32: Select Destination Cell Dialog*

Select the destination cell from the predefined cells list and click OK to complete the pattern copy.

**NOTICE**

If a pattern is copied to a different cell that uses a different gripper and where the stations definition is different, the pattern may become invalid.

6.10 Deleting Patterns

A pattern can be deleted by right clicking on the pattern in the Project Explorer and then clicking on Delete. This action can also be done by selecting the pattern and clicking on the Delete button ✗ in the general toolbar.
A.1 Gripper Pick Validation Parameters

A.1.1 Gripper Validation Rules

1. A package must be covered by at least one grip area;
2. A package cannot overlap two grip zones;
3. Part of a package center zone must be covered by the grip zone;
4. Optional requirement that a grip zone be fully covered by one or more packages;
5. Optional requirement that a grip area is fully covered by a single package;

The coverage is defined as the linear coverage along the X axis only.

A.1.1.1 Package must be covered by at least one grip area

So the following case would be invalid because package 2 and 5 are not touching grip areas.

Fig. A-1: Gripper Validation Case 1
A.1.1.2 Package cannot overlap two grip zones

The following case would be invalid because the packages are overlapping grip zone 2.

*Fig. A-2: Gripper Validation Case 2*
Appendix A

A.1  Gripper Pick Validation Parameters

A.1.1.3 Package Center Control

 Specifies the allowable position of the center of a package from the grip zone.

 - If the percentage is negative, then the center of the package can be outside the zone by the specified % of the package length.
 - If the percentage is positive, then the center of the package must be inside the zone by at least the specified % of the package length.

In short, at 0% the package center must be somewhere in the grip zone. Increase the percentage to require a larger portion of the package to be in the grip zone. Decrease the percentage to allow the center of the package to be further outside the grip zone.

Fig. A-3: Package Center Control

Fig. A-4: Gripper Validation Case 3

This case is always valid
A.1 Gripper Pick Validation Parameters

Fig. A-5: Gripper Validation Case 4
This case is always valid

Always Valid

Fig. A-6: Gripper Validation Case 5
Valid if percentage set to -20%, but invalid is set at +20%.

Package Center Control=
Positive % = Invalid
Negative % = Valid
Fig. A-7: Gripper Validation Case 6
This case is always invalid.

Always invalid.
Need to set larger negative % to make valid
A.1.1.4 Grip Zone Coverage

The “Grip Zone Full Coverage” option controls if a grip zone needs to be fully covered. Full coverage doesn’t necessarily need to be achieved by a single package. If enabled, it would invalidate the following case where only one grip area of grip zone 2 is covered.

Fig. A-8: Gripper Validation Case 7
A.1.1.5  Grip Area Coverage

The “Grip Area Single Package” option controls if a grip area needs to be fully covered by a single package. This would prevent the following case where a suction cup (grip area 2) is between to package.

Fig. A-9: Gripper Validation Case 8

Invalid if “Grip Area Single Package” = True
Appendix A

A.2 Vacuum Gripper

A.2.1 Default Rules:

1. A package must be covered by at least one grip area;
2. A package cannot overlap two grip zones;
3. Package center must be +20% inside the grip zone;
4. Require that a grip zone be fully covered by one or more package (Grip Zone Full Coverage = True);
5. Require that a grip area is fully cover by a single package (Grip Area Single Package = True);

Fig. A-10: Vacuum Gripper Validation Case 1
Appendix A

A.2 Vacuum Gripper

Fig. A-11: Vacuum Gripper Validation Case 2

Fig. A-12: Vacuum Gripper Validation Case 3
Fig. A-13: Vacuum Gripper Validation Case 4
Invalid because of rule #1: Packages are overlapping two zones.

Fig. A-14: Vacuum Gripper Validation Case 5
Invalid because of rule #2: Package 2 and 5 are not covered by a grip area.
Appendix A

A.2 Vacuum Gripper

Fig. A-15: Vacuum Gripper Validation Case 6
Invalid because of rule #3: 20% of the package 1 and 4 center areas are not covered by their grip zone.

Notice: Could be made valid by reducing the Grip Area Coverage to -20% or lower.

Fig. A-16: Vacuum Gripper Validation Case 7
Invalid because of rule #4: Zone 2 is not completely covered.

Notice: Could be made valid by setting “Grip Zone Full Coverage” to False.
Appendix A
A.2 Vacuum Gripper

Fig. A-17: Vacuum Gripper Validation Case 8
Invalid because of rule #5: Grip area 2 and 5 are not completely covered by a single package.

Notice: Could be made valid by setting “Grip Area Single Package” to false.
A.3 Clamp, Fork, and Bag Gripper

A.3.1 Default Rules:
1. A package must be covered by at least one grip area;
2. A package cannot overlap two grip zones;
3. Package center must be +20% inside the grip zone;
4. Does not require that a grip zone be fully covered by one or more package (Grip Zone Full Coverage = False);
5. Does not require that a grip area is fully cover by a single package (Grip Area Single Package = False);

Fig. A-18: Clamp Gripper Validation Case 1
Appendix A

A.3 Clamp, Fork, and Bag Gripper

Fig. A-19: Clamp Gripper Validation Case 2

Fig. A-20: Clamp Gripper Validation Case 3
A.3 Clamp, Fork, and Bag Gripper

Fig. A-21: Clamp Gripper Validation Case 4

Notice: Could be made valid by combining grip area 1 and 2 into one zone as in case 4.

Fig. A-22: Clamp Gripper Validation Case 5
Invalid because of rule #2: Package is overlapping two zones.
Fig. A-23: Clamp Gripper Validation Case 6
Invalid because of rule #3: Package on the right is not sufficiently gripped. 20% of the package center area is not covered by their grip zone.

Notice: Could be made valid by reducing the Grip Area Coverage to -30% or lower.
Specifications are subject to change without notice for ongoing product modifications and improvements.